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1 Introduction 
 

1.1 What is Palmscape? 
Palmscape is a web browser for the Palm OS.  When your Palm device is connected to the Internet, you 
can browse a website or download information. 
 
Browsing Various Web Sites with ease… 
When you browse a website that was created for viewing on a PC, Palmscape automatically converts the 
text layout and picture size to fit the Palm device screen.  Palmscape makes web browsing with Palm 
device almost as good as doing it on computers in your home and office. 
 
Useful functions to reduce communication time… 
Palmscape features offline browsing which enables you to access a web page saved in the Palm device 
internal cache even when you are not connected to the Internet.  Palmscape’s automatic sync function 
downloads a pre-specified web page and saves it to the Palm device internal cache.  These functions 
facilitate operations and reduce communication time. 
 
1.2 Before Using Palmscape 
This manual is for Palmscape 3.1.  Palmscape is a web browser for the Palm device.  Please refer to 
the operation manual of your Palm device for details on the connection of the Palm device to 
communication tools, such as modem, installation of application software, and Internet connection 
configurations 
1.2.1  Warning, Caution and Limitations 

Warning: Please read the End User License Agreement 
Before using Palmscape, please read the End User License Agreement for all software.  After consenting 
to the clauses of the agreement, install all software.  The End User License Agreement is included at the 
end of this manual.   
 
Caution 
• The copyright of this manual belongs to ILINX, Inc. 
• Copy of this software or manual in whole or in part is forbidden. 
• The software and manual can be changed without prior notice. 
• We do not take any responsibility for the results of using the software and manual. 
 
Limitations 
You may encounter the Channel options on Palmscape. However, these are *not* available in the English 
version. These functions are available in the Japanese version, however.  (The English version has been 
modeled after the Japanese version.) 
 
Trademark 
Palm, HotSync is a trademark of Palm Computing, Inc. or its subsidiary and PalmOS is a trademark of 
Palm, Inc. or its subsidiary. 
Other brands and product names maybe trademarks of each owner. 
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1.2.2  Terminology 

 
 

Tap 
To touch the screen with the Stylus tip momentarily is 
called “tap”.  Tap to “Set”/”Select” operations. 
Drag 
To draw the Stylus tip along the screen slowly is called 
“drag”.  You drag to “Move” an item on the screen. 
Drop-Down Menu 
An item with a down arrow on the left is called a 
“Drop-Down Menu”.  When you tap the down arrow, a 
menu appears. 
Check Box 
The box displayed for selecting an item on the setting 
screen is called a “Check Box”.  When you tap the 
Check Box, a check mark appears in the box which 
means that the item is selected. 
Selection Box or Box 
The dotted-line frame displayed for selecting an item on 
setting screens is called a “Selection Box” or “Box”.  

When you tap the box, the screen is switched or the box 
turns blue.  When the box is blue, it means that the 
item is selected. 
Scroll Button 
The buttons vertically aligned at the lower part of the 
Palm device is called “Scroll Buttons”.  You use these 
buttons to move the cursor or to scroll the screen. 
[Menu] Button 
The button to display application menu, [Menu] button, is 
on the lower left corner of the screen.  By tapping the 
[Menu] button, a menu appears on the upper portion of 
the screen. 
[Home] Button 
The button to display the [Application Startup] screen, 
the [Home] button, is on the lower left corner of the 
screen.  By tapping the [Home] button, the [Application 
Startup] screen appear.
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2 Setup Guide 
 

2.1 Installing Palmscape 
Palmscape is not installed in the Palm device that you have purchased.  To use Palmscape, refer to the 
[Readme] text file on how to install the application software. 
 
2.2 Starting Palmscape 
 

 

2.3 Basic Screens 
2.3.1 Browse Screen 

 
 
 
 
The browse screen displays web pages. 
The Browse icons displayed at the lower part of 
the screen are used to perform the main 
operations such as displaying web pages. 
The Browse icons may vary depending on the 
communication status. 
 
 
 
 
 
 
2.3.2 Selection Screen 

 
 
 

 

 
 
 
To start up Palmscape, tap the [Home] button on the Palm
device to view the [Application Launcher] screen.  By
tapping the [Palmscape] icon, the Palmscape startup
screen appears. 
Palmscape User’s Manual 

 
Tapping the [Select] icon on the [Browse] mode 
brings you to the [Selection] mode.  This mode is for 
managing data stored in the Palm device internal 
cache, such as [Bookmark], [File] and [History]. 
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2.3.3 Prefs Dialog 
Select [Prefs…] in the [Options] menu to open [Prefs dialog].  This dialog is for configuring Palmscape. 
 

 
 
Connect/Disconnect Dialog 
Tapping the [Phone] icon on [Browse] mode opens the [Connect/Disconnect] dialog. 
This screen is for connecting and disconnecting the network. 
 

 
 
Menu Bar 
 

 
 
 
2.4 Settings Palmscape functions 
 
Using the [Prefs] dialog sets the functions for Palmscape. 
The Prefs dialog is used to peform the connection settings for the Internet and the basic settings for 
displaying a web page. 
 
 
 
 
 
 
 
 
 
 
 

 
Menu Items 
 
Page: 
Displays menus related to page display and management. 
Edit: 
Displays menus related to text input. 
Options; 
Displays menus related to Palmscape settings. 
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Prefs Dialog – Part 1 
To open the Prefs dialog, tap the [Menu] button of the Palm device and then select [Prefs…] from the 
[Options] menu. 

 
1. Encoding (Text Code) 
Selects the language for displaying a web page.  
To display web pages in English, select [Western]. 
2. Cache Size 
Sets the cache size for storing web page data. 
3. Proxy 
When the proxy is set, web page are displayed 
faster. To use proxy, check the type of proxy (http 
or ftp) designated by your provider and enter the 

address (URL).  The port number is normally set 
to “8080”. 
4. Timezone 
Sets the timezone for Palmscape. 
5. Show Tips 
When an icon or link is tapped, its description 
pops up.  Image: Opens the [Image Support] 
dialog for the settings for image display. 

 
 
Prefs Dialog – Part2 
To open another Prefs dialog, tap the Arrow of the Prefs dialog 

 
 
1. Load Images 
If you select [When Requested], Palmscape 
displays a page without the pictures, which 
reduces the communication time. 
Always Always displays a page with images 
When Requested Displays only text on a page, 
without the pictures.  When you select [Load 
Images] in the [Page] menu, a connected web 
page is displayed. 
2. (Proxy) Server 
Enter the URL of the proxy server used for the 
image display. 
3. Security 
Palmscape has a security function that determines 
the possibility of danger from a network point of 
view and displays a warning message before 
accepting cookies issued by Web sites or before 
downloading prc/pdb files from the Web.  Use 
the “Security Setting” dialog box to set the 
appearance of the warning display and to execute 
or suspend the process. 

4. Sync 
Sets the range for automatic cruise. 
Queued Requests & Sync Updates the bookmark 
and cache data specified for action of Sync. 
Queued Requests Updates the cache data 
specified for action of Sync. 
5. Disconnect Afterwards 
When this option sis checked, the Internet 
connection is disconnected after Sync action. 
6. Check Updates 
Set the initial URL location to be accessed while 
loading a web page when you are online. 
Everytime Always access the web server and 
downloads the latest web page. 
Use Cache Accesses [Cache] first and displays 
any old web data that is still stored in [Cache].  If 
there is no old web data in [Cache], the web 
server is accessed to download the latest web 
page.
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Security Level 
 

Security Level Updated Items Action 
Danger Safety More Safety 
Accept Confirm User Reject 

Cookies Accept Cookies Accepts cookie 
automatically without 
warning. 

Confirms users to 
accept cookie with 
warning. 

Does not accept 
cookie. 

Execute Confirm User Reject 

Local (Files) Download prc/pdb 
files 

Automatically 
download files 
without warning. 

Confirms users by 
showing warning 
whether to download 
files. 

Does not allow 
prc/pdb files to 
download. 
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3 Website Browsing 
 

3.1 Online Browsing 
3.1.1 Connect to an Internet Provider 
Tap the [Phone] icon  from [Browse] mode to open the [Connection] dialog.   
1. By tapping the [Connect] button, the line will connect to your Internet Provider.  Then the [Browse] 

screen reappears.  The [Phone] icon is displayed as  when the line is connected. 
2. By tapping the Sync button , the line will be connected to the Internet provider and the automatic 

sync function will start. 

 
3.1.2 Viewing a web page 
Open Iinx’s homepage 
When you select [About Palmscape] from the [Options] menu, the Palmscape startup screen appears.  
By tapping the [ILINX Homepage] link on the upper right side of the screen, it brings you to the ILINX 
homepage. 

 
1. Title 
Title of the web page displayed on the screen. 
2. Hyperlinked Text  
Text that are underlined are hyperlinked text.  When 
you tap here, the specified web page is opened. 
3. [Select] button 
Opens the [Selection] Mode. 
4. [Stop] button 
Stops the download of a web page. 
5. [Browse] buttons 

Controls the displays of the web pages. 
6. [Page Info] icon 
Displays information about the web page including URL 
and size. 
7. [Sync] button 
Connects to the Internet and begins downloading web 
pages in sync mode. 
8. [Phone] icon 
Connects/Disconnects to the Internet.
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3.1.3 Using the [Browse] buttons 
Palmscape saves web pages that you have accessed.  The sequence in which the pages were displayed 
is recorded in the [History] log.  You can use the [Browse] button to display the [Cache] data in the 
sequence recorded in the [History] log. 
 

 
 
3.1.4 Opening a website 
Opening a page using Hyperlink 
When you tap the underlined text or picture set was a hyperlink, the specified page is opened. 
 
URL of an HTML document .html or .htm Displays web pages. 

URL of a program .prc or .pdb Downloads programs and 
installs into Palm Device 

 
Opening a page using a URL 
The following is an example of opening the homepage of ILINX, Inc. 
To enter a URL, tap [Select] button on [Browse] screen and open the [Selection] mode. 
 
Opening a page created by a frame 
Some websites on a PC have a list of menus on the left side of the window.  And the corresponding 
information on the right side of the window changes in accordance with the selected menu.  The method 
to divide a window into the units is called “frames” and then display different information in each frame is 
called “frame display”.  The frames are displayed in separate pages due to the limitation of the screen 
size. 
 
Switching the frame display 
 
1. The [Frame] icon appears on the upper right corner of [Browse] mode when you access a frame 

display page. 
2. When you tap the [Frame] icon the [Frame image] window opens and then displays a framed graphic 

divided on the PC Window.  The shaded area is a the corresponding frame that is currently 
displayed on screen.  To switch to other frames, tap the desired white portion. 

 

 
 
 

 Back 
Displays the previous page 

 Forward 
Displays the following page recorded in the [History] log. 

 Reload 
Displays the page again. 
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3.1.5 Disconnecting the Communication Line 
Tap the [Phone] icon  from the [Browse] screen which will display the [Connection] dialog.  When you 
tap the [OK] button, the communication line is disconnected and then the [Browse] mode reappears and 
the [Phone] icon appears as . 
 
 
Change of Icon Display 
The icons to be displayed at the lower part of the browser screen change in accordance with the 
communication status. 
 
 
Offline Status  

 Displayed in gray (when disabled) 
 Displays the history log. 

(If there is no log record, these arrow symbols are displayed in gray and 
browsing is disabled) 

 Offline status. 
 
Download Status  

 Download is cancelled when this icon is tapped. 
 Displays the history log. 

(If there is no log record, these arrow symbols are displayed in gray and 
browsing is disabled) 

 Online status. 
 
Online Status  

 Displayed in gray (when disabled) 
 Displays the history log. 

(If there is no log record, these arrow symbols are displayed in gray and 
browsing is disabled) 

 Online status. 
 
 
 
3.2 Offline Browsing 
 
Palmscape allows you to browse web pages using data stored in [Cache] even when the Palm device is in 
offline status (not connected to the Internet). 
 
 

 
 
3.2.1 Cache and Log 
Palmscape stores the pages you have browsed to your Palm device’s internal cache as [Cache] data.  It 
also records the sequence of pages you browsed as [History] log data. 
 
 
 
 
 
 
 
 

If you try to open a web page that does not have its data stored in
[Cache], the [Retrieval Method] dialog will open.  You can use this
dialog to specify automatic data download to [Cache], to be
performed when you connect to the Internet the next time. 
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Cache 
To view information stored in [Cache], tap the [Select] button proceed to [Selection] mode and tap the [File] 
tab and select the [Cache] option.  The [Cache] data is displayed from information saved at the earliest 
date and time. 

 
1. Title 
Data name of [Cache].  If you tap the title when you are in offline mode, and if there is data in [Cache], 
the [Browse] mode reappears and the corresponding web page is displayed.  If there is no data in 
[Cache], the [Retrieval Method] dialog opens. 
2. Document Icon 
Displays the [Cache] status and result of the [Sync] function.  When you tap this icon, detailed 
information about the data is displayed in the [About This Page] dialog. 
 
Filter Function 
The [Cache] list displays a list of data shown with a specific [Document] icon.  The data shown with the 
[Document] icons in reverse video (white on black background) at the bottom of the screen are displayed 
in the list.  When you tap a [Document] icon in reverse video, this icon is displayed in normal video (black 
on white background) and the data corresponding to this [Document] icon is not displayed in the list. 
 
History Logs 
To view the [History] log data, tap [Select] button and then, tap the [History] tab.  The [History] log data is 
displayed according to the sequence when browsing the web pages. 
 
 

 
 
Document Icons 
The document icon is different depending on the [Cache] status and result of [Sync] function. 
 
Document Icon Description [Cache] 

 Page stored in cache Yes 
 Page set with Lock Function Yes 
 Page already updated but unread Yes 
 Page with update requested Yes 

No icon Page not stored in cache No 
 
 

1. Title 
The title is the data name of the [History] log.  When
you tap the title, and if there is [Cache] in offline mode,
the [Browse] screen reappears and the corresponding
web page is displayed.  If there is no data in [Cache],
then the [Download] dialog is opened. 
2. Document Icon 
This displays the [Cache] status.  When you tap this
icon, the detailed information about the data is
displayed in the [About This Page] dialog. 
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3.2.2 Browsing with the Browse Buttons 
You can display the [Cache] data using the browse buttons corresponding to the [History] log sequence. 
 

 

 
 
 

 
3.2.3 Browsing from [Selection Screen] 
Tap [Select] mode and either select [Cache] from the [File] tab or [History] log tab to display the list of data. 
If you tap the title of a page with   , the [Browse] mode display reappears and the data is displayed. 
 

 Back:  Displays the previous [History] log. 
 Forward: Displays the next [History] log. 
 Reload:  Reloads the [Cache] data. 
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4 Useful Functions for Easy Browsing 
 
4.1 Bookmark 
What is a Bookmark? 
Bookmark is a function for saving the URL of a web site.  Once you have bookmarked a URL, you can 
browse the corresponding web page by simply tapping this title on the [Bookmark] list without entering the 
URL.   
 
Viewing the Bookmark List 
Tap [Select] button and then tap the [Bookmark] tab.  Select the desired category from the dropdown 
menu of the [Bookmark] tab.  A list of bookmarks in the selected category will appear starting from the 
newest data in the order of registration. 

 
 

Category 
Displays category of bookmarks.  You can set up 
to 15 categories. 
Title 
Displays the Bookmark title.  If you tap the title 
when you are online, the [Browse] screen will 
reappear and the corresponding web page is 
displayed.  If you tap the title when you are 
offline, the [Download] dialog will open.  If there 
is a data in [Cache] in offline mode, the [Browse] 
screen reappears and the corresponding web 
page is displayed.  If there is no data in [Cache], 
the [Download] dialog is opened. 
[Pencil] Icon 
Indicates the setting of the automatic cruise 

function of bookmark.  When you tap the [Pencil] 
icon, the [Edit Bookmark] dialog for editing 
information about bookmarks will open. 
[Document] icon 
Indicates the bookmark [Cache] status.  The 
document icon descriptions are the same as those 
of [Cache]. 
[Close] button 
Close [Selection] mode and returns to [Browse] 
screen. 
[URL] button 
Opens the [Open URL] dialog. 
[New] button 
Opens the [Edit Bookmark] dialog. 

 
 
Registering Bookmarks 
You can register up to 32,000 entries.  There are three ways to register a bookmark. 
1. Registering from the [Edit Bookmark] dialog 
2. Registering a web page being displayed 
3. Registering a web page from the [History] log 
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Registering from the [Edit Bookmark] dialog 
 

 
 
Registering a web page being displayed 
 

 
 
 
Registering a web page from the [History] log 
 

 
 
 
Editing Bookmarks 
The information associated with a bookmark is entered in the [Edit Bookmark] dialog. 
To open the [Edit Bookmark] dialog, open [Selection] mode and tap the [Bookmark] tab.  Then, tap the 
[Pencil] icon of the bookmark you wish to edit. 
 
 
Deleting Bookmarks 
To delete a bookmark, open the [Edit Bookmark] dialog and tap [Delete…] to display the [Delete 
Bookmark] dialog.  Then, tap [OK]. 
To open the [Edit Bookmark] dialog, open [Selection Mode] and tap the [Bookmark] tab.  Then, tap the 
[Pencil] icon of the title of a web page you wish to delete. 
 
 
 

Tap [New] while the [Bookmark]
list is displayed and open the
[Edit Bookmark] dialog.  Enter a
bookmark name and URL and tap
[OK].  Now, the bookmark is
registered. 

To register a web page currently displayed on [Browse] screen to a
bookmark, tap [Add to Bookmark…] in the [Page] menu to open the
[Edit Bookmark] dialog.  Check the bookmark name and URL, and
tap the [OK] button.  Now, the bookmark is registered 

Tap the [Document] icon while the [History] log list is displayed to
open the [About This Page] dialog.  Tap [Add to Bookmark] to open
the [Edit Bookmark] dialog.  Check the bookmark name and the URL
and tap the [OK] button.  Now, the bookmark is registered. 
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4.2 Palmscape and Memo 
Palmscape allows you to browse data stored in your Palm device and save web pages in Memo. 
Browse Memo 
To display data stored in Memo on [Browse Screen] of Palmscape, open [Selection Mode] and tap the memo title in the 
[Memo] list of the [File] tab.  To display the [Memo] list, open [Selection Mode], tap the [File] tab, tap the down arrow, 
and select [Memo]. 

 
Saving Web Pages in Memo 
To save a web page in Memo, select [Save as Memo] from the [Page] menu while in [Browse] mode. 
A web page displayed in [Browse] mode is saved in Memo as text without images. 
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5 Data Management 
 

5.1 Viewing the Page Information 
To view detailed information about a web page displayed on [Browse] screen and data stored in 
[Bookmark] and [Cache], display the [About This Page] dialog. 
 
[About This Page] Dialog 
To display the [About This Page] dialog, select the option [Info] from the [Page] menu. 
You can also display the [About this Page] dialog by opening the [Selection Mode], tapping the [Bookmark] 
tab or [History] tab, and then tapping the [Document] icon  on the right side of the list. 
Or, you can display the [About This Page] dialog by opening [Selection Mode], tapping the [File] tab to 
select [Cache] option, and then tapping the[Document] icon  on the right side of the list. 
 

 

 
URL 
URL of this page. (You can edit this data.) 
Mime-Type 
Type of document this page contains. 
Cached 
Indicates the date and time at which this page was 
downloaded. 
Modified 
Indicates the date and time at which this page was 

last updated on the web. 
Expires 
Indicates the effective period of this page. 
Size (o/c) 
Amount of data in this page.  Indicates the page 
size (o) and the amount used in cache (c). 
Lock 
If this check box is marked, the page cannot be 
deleted from [Cache]

 

5.2 Memory Management 
5.2.1 Clearing the Internal Cache 
You can delete all data of Palmscape stored in your Palm device.  To delete all data at one time, open the 
[Clean Up] dialog, specify the deletion conditions, and tap the [Delete] button. 
To open the [Clean Up] dialog, select the option [Clean Up…] from the [Page] menu at the [Browse] 
screen. 
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You can delete three types of data – [Cache], [History] and [Cookies].  Tap the delete conditions for each 
data. 
Delete Conditions 
None  : No deletion.  The data is not deleted and remains in memory. 
Not Locked : Deletes all data except data that is Locked. 
All  : Deletes all data. 
 
Note: The Channel option is not available in Palmscape English version. 
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6 Others 
6.1 Troubleshooting 
When Unable To Display Web Page 
 
Web page does not display 
Cause: Incorrect setting of the screen display. 
Solution: Confirm the following items in the “Settings” dialog box 

* “Image Load”: Change to “Always” if it is set to “If Requested” 
* “Proxy”: enter pds.ilinx.co.jp as the Proxy URL server 
To display the “settings” dialog box, tap the “Menu” button on the “browse screen” and select 
“Settings” from the “Option” menu. 

 
All or part of the web page is not displayed after loading is finished. 
Cause: Palmscape does not support some JAVA scripts, JAVA Applets, Flash, ShockWave, 

QuickTime, or Sound playback.  Web pages composed in these formats are or displayed, 
or are only partially displayed.. 

Solution: Use a browser other than Palmscape 
 
It takes a long time to load a web page. 
Cause: The web site or the proxy server is congested.. 
Solution: Connect to another provider or access point.  Or, try again later. 
 
Web Pages are not loading. 
Cause: The URL is not correct, or the URL does not exist. 
Solution: Confirm the input data when you enter a URL form the “Open URL” dialog box. 

The following symbols are easily mistake: 
* carat [^] and tilde [~]  
* hyphen [-] and underscore [_] 
* numerical zero [0] and alphabetical O [O] 
When a URL is opened from “Bookmark” or “Cache”, it may  not be displayed due to a 
change or deletion of the URL.  Input the entire link again from the start of the URL, paying 
special attention to the domain ending (e.g. ~.com/ or ~.net/) 

 
When Unable to Perform HotSync 
After making a line connection, you cannot perform HotSync with the PC 
Cause: HotSync cannot be performed while there is a line connection. 
Solution: If the telephone icon shows that the there is a line connection, disconnect.  In other cases, 

please refer to the operation manual of your Palm Device. 
 
 
Please also check our FAQ pages at http://www.ilinx.co.jp/en/support/faq.html 
 

Technical Support 
In order to receive technical support on Palmscape, you need to include the Registration Code 
that you have obtained from Palmgear H.Q. when you purchased Palmscape.  If you do not have 
a Registration Code, please purchase Palmscape from Palmgear H.Q.- http://www.palmgear.com/, and 
you will be provided the Registration Code from Palmgear upon purchase. 

http://www.ilinx.co.jp/en/support/faq.html
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6.2 End User License Agreement 
 
 
Before using the following software and related software (hereinafter referred to as "Software"), please read the 
following documentation carefully. 
 Palmscape 3.1.x English Language Version    
Software and incorporated software in Software are protected by the Copyright Law and international treaties regarding 
copyright, as well as other intellectual property laws and treaties. 
ILINX Inc. (hereinafter referred to as "ILINX") holds and owns the copyright and the right to license Software. 
Software includes third party ( hereinafter referred to as "Vendor") software that ILINX has legitimately been granted a 
license to use. 
The Software is licensed, not sold to you as long as you comply with the terms and conditions set forth in this 
Agreement. 
Please note that you are not permitted to use Software if you don't agree to any and all provisions of this Agreement. 
 
1. GRANT OF LICENSE 
ILINX grants the right to use Software, in accordance to the provisions under this Agreement, to the first user who 
installs Software on a Personal Digital Assistant (hereinafter referred to as "PDA") that supports the Palm OS 3.x, or to 
the first user of the PDA on which Software is pre-installed. 
 
2. RESTRICTIONS 
You may install and use Software on only one PDA for ordinary use and in the form of object code and shall not install 
on two or more PDAs at the same time. 
You shall not make copies of Software in either electronic or hardware form except for initial installation on PDA, loading 
into temporary memory or peripheral devices for ordinary use, or making backup copies.  
You shall not modify, translate or merge Software, analyze it by reverse engineering, decompile, disassemble, or create 
derivative works in any form or by any means from the object code of Software.  
This license Agreement does not permit the use of ILINX's trademark or service mark; therefore you may not remove, 
change or obscure ILINX's indication or notice of copyright, trademark, or other proprietary rights. 
 
3. OTHER RIGHTS GRANTED   
You are not granted any patent, copyright, trademark, or other proprietary rights in whole or in part that ILINX owns on 
Software, and shall not lease, transfer, distribute (including transmission through the Internet or other networks, and also 
recording on the servers connected to the networks to make such transmission possible), or sublicense Software to a 
third party. 
 
4. TRANSFER OF LICENSE   
You may transfer the right to use Software to a third party by assigning any and all rights and obligations under this 
Agreement and 1) transferring in whole all types of medium, all copies in any form and documentations, or 2) 
transferring them in part and completely destroying whatever was not transferred whether tangible or electrical. However, 
you agree and certify that Software will not be exported outside the United States except as authorized and as permitted 
by the laws and regulations of the United States. If Software has been rightfully obtained outside of the United States, 
you agree that you will not re-export Software, except as permitted by the laws and regulations of the United States and 
the laws and regulations of the jurisdiction in which you obtained Software.  In no way shall the copyright notice be 
changed or removed from Software and documentation be transferred. If any condition in this Article is not fulfilled, the 
transfer of the right shall not be in effect. The same rule shall apply to the next third party who is in line to receive the 
transferred right. 
 
5. TERM OF LICENSE   
Your first use of any part of Software shall be regarded as your acceptance of the terms and conditions under this 
Agreement and shall validate it at the same time. 
 
6. LIMITED WARRANTY 
ILINX warrants that for a period of forty-five (45) days from the date of delivery of the licensed Software, it will replace or 
repair within its discretion, the media and related documentations provided by ILINX , if there are any defects on them. 
THESE WARRANTIES REPLACE ALL OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. 
THIS SOFTWARE DOES NOT HOLD DURABILITY AGAINST PHYSICAL INCIDENTS OR MECHANICAL FAILURE 
AND IS NOT INTENDED FOR USE IN HIGHLY STABLE AND SECURE ENVIRONMENTS. ILINX OR VENDOR DOES 
NOT WARRANT THAT SOFTWARE WILL MEET EACH USER'S REQUIREMENTS; THAT SOFTWARE INSTALLED 
ON PDA WILL WORK COMPLETELY WITH OTHER INSTALLED SOFTWARE ON SUCH PDA; THAT OPERATION OF 
SOFTWARE WILL BE UNINTERRUPTED; THAT DURING CONNECTION WITH THE INTERNET OR OTHER 
NETWORKS SOFTWARE WILL BE ERROR-FREE AND WILL NOT DAMAGE HARDWARE, SOFTWARE, AND DATA 
CONNECTED WITH SUCH NETWORKS; OR THAT SOFTWARE WILL NOT EFFECT YOUR OR THIRD PARTY'S 
ELECTRONIC INFORMATION IN ANY WAY. 
IN NO EVENT SHALL ILINX NOR VENDOR BE LIABLE FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL,  OR 
INDIRECT DAMAGES, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, 
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BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION/DATA, OR ANY OTHER PECUNIARY LOSS 
ARISING OUT OF THE DISTRIBUTION, INSTALLATION, MAINTENANCE, USE OR INABILITY TO USE, SUCH AS 
THE INTERRUPTION OF SOFTWARE IMPLEMENTATION. AND IN NO EVENT SHALL ILINX'S NOR VENDOR'S 
TOTAL LIABILITY TO YOU FOR ALL DAMAGES, LOSSES, AND CAUSES OF ACTION (WHETHER IN CONTRACT, 
TORT, OR OTHERWISE) EXCEED THE AMOUNT OF LICENSE FEE PAID BY YOU. SUCH LIMITATION OF 
LIABILITY MAY NOT APPLY TO YOU IF THE DAMAGES, LOSSES OR CAUSES OF ACTION WHICH ARE CAUSED 
BY INTENTIONAL ACT OR GROSS NEGLIGENCE OF ILINX OR VENDOR.  
 
7. TERMINATION OF LICENSE   
This Agreement and your rights hereunder shall automatically terminate if and when you 1) fail to comply with any 
provision of this Agreement, 2) transfer the right to use Software to a third party according to this Agreement, or 3) 
destroy Software and all its copies and related documentation.  
Upon termination, you shall cease any and all use of Software and destroy all copies including written documentation 
and modified copies, if any. 
 
8. RIGHTS AGAINST INFRINGEMENT 
In the event you are reasonably assumed to have infringed any provision under this Agreement, ILINX shall reserve the 
right to 1) make an on-site-search of the premises, where you are reasonably assumed to hold any media or copies of 
Software, to find any facts related to the infringement, and 2) browse, make copies and/or take photos of the related 
materials. 
On finding the fact of your infringement, ILINX shall have the right to prohibit your use of Software and claim the 
indemnity for any direct or indirect damages incurred by the infringement. 
ILINX shall not be liable for any property or psychological damages to you resulting from the search, even if your 
infringement is not found. 
 
9. GOVERNING LAW AND PRIMARY COURT 
This Agreement shall be governed and construed in accordance with Japanese laws. ILINX and you submit to the 
non-exclusive jurisdiction of the Tokyo District Court in Japan with respect to all dispute arising from the interpretation 
and performance of this Agreement, wherever the parties' venues or places of disputes are located and regardless to 
the amount in dispute. Each party hereby agrees to waive its right to demand a jury trial for any cause of action. 
  
 
10. SERVERABILITY 
Should any provision of this Agreement be or become illegal, invalid or unenforceable, the legality, validity, and 
enforceability of the remaining provisions of this Agreement shall not be affected or impaired thereby. 
 
11. ENTIRE AGREEMENT 
This Agreement is the entire Agreement to date between you and ILINX, and supersedes any such prior written or oral 
agreement regarding Software.  
 
12. US GOVERNMENT RESTRICTED RIGHTS 
If Software is acquired under the terms of a proposal or agreement with the United States Government or any contractor 
thereof, Software is subject to the following: (a) For acquisition by or on behalf of civilian agencies, as necessary to 
obtain protection as "commercial computer software" and related documentation in accordance with the terms of this 
Commercial Software Agreement as specified in 48 C.F.R. 12.212 of the Federal Acquisition Regulations and its 
successors; (b) For acquisition by or on behalf of units of the Department of Defense ("DOD") as necessary to obtain 
protection as "commercial computer software" and related documentation in accordance with the terms of this 
commercial computer software license as specified in 48 C.F.R. 227-7202-2 of the DOD F.A.R. Supplement and its 
successors. 
 
______________________________________________ 
Palm and Palm OS are registered trademarks of Palm Inc. 
 
 
 
 


